Licence Agreement

Important
Before using this software disk(s), carefully read the Terms and Conditions of Sale contained in this help.

By using the Digita software disk(s) you shall indicate your acceptance of the terms and conditions of use set out in
the help. All rights reserved. This product is sold subject to the Company's standard Terms And Conditions of Sale.
No part of this product may be reproduced, stored in a retrieval system or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording or otherwise without the prior written permission of Digita Open
Systems Ltd. No liability shall attach to the authors or Digita Open Systems Ltd or any associated companies for loss
or damage of any nature suffered as a result of reliance on any of the contents of this product or any errors or
omissions on its contents.



Terms and Conditions of Sale

Digita International Ltd

1. Definitions
In these Terms and Conditions of Sale:

"the Company" shall mean Digita International Limited of Black Horse House Exmouth Devon EX8 1JL

"the Buyer" shall mean the person, firm, company or buyer who accepts a quotation of the Company or whose order
for the Goods is accepted by the Company

"the Goods" shall mean the software, equipment, parts or services to be supplied by the company (including any
instalments or part of them)

2. Basis of Sale

2.1 ltis a contractual responsibility to inform the Company of all problems in writing. The Company has the right to
repair and replace.

2.1.1 The Company policy to utilise the latest technology and in order to achieve this it will be necessary from time to
time for the Buyer to upgrade their hardware.

2.2 All quotations given by the Company are subject to written confirmation at the time of acceptance by the
Company upon receipt of the Buyer's purchase order and remittance. Acceptance and execution of orders is
dependent upon the availability of Goods and the absence of any circumstances beyond the Company's control
which may hinder or prevent execution or acceptance.

2.3 No conditions or terms stipulated in any other communication or document shall vary or annul any of these
conditions except if they were expressly consented to in writing by an officer of the Company.

2.4 The company's employees or agents are not authorised to make any representations concerning the Goods
unless confirmed by the Company in writing. In entering into the contract the Buyer acknowledges that it does not rely
on, and waives any claim for breach of, any such representations which are not so confirmed. The Company does not
have agents only independent distributors.

2.5 Any advice or recommendation given by the Company or its employees or distributors to the Buyer or its
employees or agents as to the storage application or use of the Goods which is not confirmed in writing by a Director
of the Company is followed or acted upon entirely at the Buyer's own risk, and accordingly the Company shall not be
liable for any such advice or recommendation which is not so confirmed.

2.6 Any typographical, clerical or other error or omission in any sales literature, quotation, price list, acceptance of
offer, invoice or other document or information issued by the Company shall be subject to correction without any
liability on the part of the Company.

2.7 If the Goods are to be manufactured or any software is to be written by the Company in accordance with a
specification submitted by the Buyer, the Buyer shall indemnify the Company against all loss, damages, costs and
expenses awarded against or incurred by the Company in connection with or paid or agreed to be paid by the
Company in settlement of any claim for infringement of any patent, copyright, design, trade mark or other industrial or
intellectual property rights of any other person which results from the Company's use of the Buyer's specification.

2.8 The Company reserves the right to make any changes in the specification of the Goods which are required to
conform with any applicable safety or other statutory requirements or, where the Goods are to be supplied to the
Company's specification, which do not materially affect their quality or performance.

2.9 No order which has been accepted by the Company may be cancelled by the Buyer expect with the agreement in
writing by a Director of the Company and on terms that the Buyer shall indemnify the Company in full against all loss
(including loss of profit), costs (including the cost of all labour and materials used), damages, charges and expenses
incurred by the Company as a result of cancellation.

2.9.1 The Company reserves the right to refuse the supply goods given reasonable grounds or suspicions.

3. Price

3.1 Quoted prices are ex works unless otherwise stated and include the cost of normal packaging but exclude
delivery, transit insurance (which are charged extra at cost). VAT and installation charges (where applicable) shall be
paid in addition by the Buyer. Any query by the Buyer of any invoice rendered by the Company must be made in
writing within 30 days of the date of invoice or the parties agree that such invoice shall be deemed accepted and any
purchaser's query waived. The Prices for the goods shall be those ruling at the date of despatch and the Company
reserves the right to amend its quoted prices at any time prior to the date of despatch. Sales made directly to the
general public using current Company standard retail price list include VAT.



4. Terms of Payment
4.1 Normal terms are remittance in advance with order or invoice.

4.2 The time for payment of invoices shall be of the essence of the Contract.
4.3 By cheque or approved credit card (subject to surcharge of 2.5%).

5. Risk and Property
5.1 Risk of damage to or loss of the Goods shall pass to the Buyer:

5.1.1 In the case of Goods to be delivered at the Company's premises, at the time when the Company notifies the
Buyer that the Goods are available for collection; or

5.1.2 In the case of Goods to be delivered otherwise than at the Company's premises, at the time of delivery, or if the
Buyer wrongfully fails to take delivery of the Goods, or the time when the Company has tendered delivery of the
Goods.

5.2 Notwithstanding delivery and the passing of risk in the Goods, or any other provision of these Conditions, rights to
the licence in the Goods shall not pass to the Buyer until the Company has received in cash or cleared funds
payment in full of the price of the Goods and all other goods agreed to be sold by the Company to the Buyer for which
payment is then due.

5.3 Until such time as the property in the Goods passes to the Buyer, the Buyer shall hold the Goods as the Company
fiduciary agent and bailee and shall keep the Goods separate from those of the Buyer and third parties by being
properly stored, protected, insured and identified as the Company's property. Until that time the Buyer shall be
entitled to resell (if a distributor) or use the Goods in the ordinary course of its business, but shall account to the
Company for the proceeds of sale or otherwise of the goods, whether tangible or intangible, including insurance
proceeds, and shall keep all such proceeds separate from any moneys or property of the Buyer and third parties and,
in the case of tangible proceeds, properly stored, protected and insured.

5.4 Until such time as the licence of the Goods passes to the Buyer the Company shall be entitled at any time to
require the Buyer to deliver up the Goods to the Company and, if the Buyer fails to do so forthwith, to enter upon any
premises of the Buyer or any third party where the Goods are stored and repossess the Goods.

5.5 The Buyer shall not be entitled to pledge or in any way charge by way of security for any indebtedness any of the
Goods which remain the property of the Company, but if the Buyer does so all moneys owing by the Buyer to the
Company shall (without prejudice to any other right or remedy of the Company) forthwith become due and payable.

6. Buyer's Property

6.1 The Buyer’s property and all property supplied to the Company by or on behalf of the Buyer, shall while it is in the
possession of the Company or in transit to or from the Buyer be deemed to be at the Buyer's risk and the Buyer shall
insure accordingly. The Company shall be entitled to make a reasonable charge for the storage of any of the Buyer's
property left with the Company before receipt of the order or after notification to the Buyer of completion of the work.

7. Loss or Damage in Transit or Non—-Delivery

7.1 The Buyer shall examine the Goods immediately they are delivered. The Company reserves the right to reject
claims in respect of shortages or damage in transit or non—delivery unless the same are submitted in writing to the
Company within 4 days after delivery of Goods or in the case of non—delivery 7 days after the due date of delivery.

8. Late Delivery
8.1 Dates for delivery are approximate only. Time of delivery shall not be the essence of the Contract.

8.2 Whilst the Company will use its best endeavours to deliver the goods in accordance with the Buyer's
requirements, the Company will not be liable for any consequences of late delivery however caused.

9. Software Licence

Note: By breaking the seal on the package containing the disks and personalising the product you agree to be bound
by these terms and conditions.

9.1 The disk, tape, software program, instruction book or other hard copy ("The program") is sold to the Purchaser
and any other property over which intellectual property rights are held by the Company or third parties which are
included in or on the disk, tape, instruction manual or other hard copy item included with the software are licensed to
the end user in accordance with the Company's standard software licence conditions set out below. The Buyer
acknowledges that the software will only be sold subject to the licence.

9.2 Software Licence Conditions

9.2.1 The Company's software products are protected by English Company Law and international treaties relating to
intellectual properties, any breach of which can result in legal action being taken against the original licensee of the



product. The licensee can transfer the software from one computer to another as long as it is only used on one
computer at a time. The Company agrees to grant the conditions of this non—transferable and non—exclusive licence
to use their software.

9.2.2 There is a one-off non-refundable licence fee for all software due for payment with order.

9.2.3 Where applicable-Software Continuity, Support and Maintenance: This cost is due per annum (in advance) after
expiry of free support period which provides technical support and software maintenance. This is non-optional and is
in addition to the one-off payment of the licence fee.

9.2.4 The Company reserves the right to increase costs for software continuity, support and maintenance also to
increase machine specifications in the light of advances in technology and on-going development.

9.2.5 The Company reserves the right to withdraw its products from the marketplace at any time.

9.3 Program Licence

9.3.1 Each program licence authorises the Buyer to use the licensed programs on any single user system or
networked system. This agreement and the licenses, Programs and documentation may not be assigned sub—
licensed or otherwise by the Buyer without written consent from the Company.

9.4 Effective Date

9.4.1 The licence is effective from the date that the Programs are received by the Buyer. The Company may
discontinue the licence or terminate this agreement with written notice if the Buyer fails to comply with the terms of
the agreement.

9.5 Documentation and Software
9.5.1 The Buyer shall not copy in whole or part any licensed documentation provided by the Company.

The licensed Program can be copied in whole or part sufficiently for the sole use of the Buyer within the licence
system for back—up purposes in support of the Buyer's use of the licensed program on design on designated
equipment. Any such copies of the licensed Program shall remain the property of the Company. The buyer may not
distribute or otherwise make the licensed Program available to any third party. If the Buyer should wish to use the
licensed Program on any other than the designated equipment the Buyer must purchase further copies from the
Company.

9.6 Termination of Licence

9.6.1 Within one month following termination, the Buyer will provide the Company in writing confirmation that all
copies of the Program and documentation have been destroyed. All original software and documentation must be
returned to the Company by Registered Post at the cost of the Buyer.

10. Warranty — Software
10.1 The provisions set out below relate to the Program only.

10.2 If you discover physical defects in the media on which the Program is distributed or in the documentation, the
Company will replace the media or documentation at no charge to the Buyer provided the Buyer returns the item to
be replaced with proof of purchase to the Company during the 30 day period after you purchased the Program.

10.3 The Company excludes any and all implied warranties, including warranties of merchantability and fithess for a
particular purpose and limits the Buyer's remedy to return of the program and the documentation to the Company for
replacement. Although the Company has tested the Program and reviewed the documentation the Company makes
no warranty or representation either express or implied with respect to the Program or the documentation. The
company does not warrant that the functions contained in the Program will meet the Buyer's requirements or that the
operation of the Program will be uninterrupted or error free or that Program defects will be corrected. As a result the
program and the documentation are licensed "as is" as a tool used by a professionally qualified user and the Buyer is
assuming the entire risk as to its quality and performance. It is important that all software problems must be reported
immediately in writing to the Company at the time of occurrence.

10.4 Neither the Company nor anyone else who has been involved in the creation, production or delivery of the
Program or documentation shall be liable for any direct, indirect, special, consequential, or incidental damages arising
out of the use, results of use, or inability to use the Program or documentation or its back—up copy, even if the
Company has been advised of the possibility of such damages or claim. In particular the Company shall have no
liability for any programs stored or used with the Program or back—up copy, including the cost of recovering such
programs or data. The warranty and remedies set forth above are exclusive and in lieu of all others, oral or written,
express or implied. No Company, dealer, agent or employee is authorised to make any modification or addition to this
warranty.



11. Warranty — Goods
11.1 The provisions set out below relate to Goods other than the Program.

11.2 Subject as expressly provided in these Conditions, and except where the Goods are sold to a person dealing as
a consumer (within the meaning of the Unfair Contract Terms Act 1977), all warranties, conditions or other terms
implied by statute or common law are excluded to the fullest extent permitted by law.

11.3 Any claim by the Buyer which is based on any defect in the quality or condition of the Goods or their failure to
correspond with specification shall (whether or not delivery is refused by the Buyer) be notified to the Company within
7 days from the date of delivery or (where the defect or failure was not apparent on reasonable inspection) within a
reasonable time after discovery of the defect or failure. If delivery is not refused and the Buyer does not notify the
Company accordingly, the Buyer shall not be entitled to reject the Goods and the Company shall have no liability for
such defect or failure, and the Buyer shall be bound to pay the price as if the Goods had been delivered in
accordance with the Contract.

11.4 Where any valid claim in respect of any of the Goods or their failure to meet specification is notified to the
Company in accordance with these conditions, the Company shall be entitled to replace the Goods (or the part in
question) free of charge, at the Company's sole discretion, refund to the Buyer a maximum of 1.25 (one and one
quarter) the price of the Goods of actual fee paid (or a proportionate part of the price), but the Company shall have no
further liability to the Buyer.

11.5 Except in respect of death or personal injury caused by the Company's negligence, the Company shall not be
liable to the Buyer by reason of any representation, or any implied warranty, condition or other term, or any duty at
common law, or under the express terms of the Contact, for any consequential loss or damage (whether for loss of
profit or otherwise) costs, expenses or other claims for consequential compensation whatsoever (and whether caused
by the negligence of the Company, its employees or distributors or otherwise), which arise out of or in connection with
the supply of the Goods or their use or re—sale by the Buyer except as expressly provided in these Conditions.

11.6 The Company will not be held responsible for any work or activity conducted by any third party, contractor,
consultant or the like. Any work so authorised by the Buyer is entirely at their risk. Any work undertaken by the
Company employees must be confirmed in writing by a director of the Company. It is at the Company’s sold discretion
whether it repairs or gets involved in technical assistance.

12. Returns Procedure

12.1 A returns authorisation number must first be obtained from our customer service department by telephone or
letter. Returned goods must be accompanied by a copy of the original invoice relating to purchase. Goods returned
must be in the original packaging and in a clean resalable condition. Goods returned otherwise will at the Company's
discretion be either refused or a further additional re—stocking fee charged to cover additional costs involved.

This document does not itself constitute an offer of sale. We reserve the right to vary the specification at any time,
withdraw, modify or amend any item without prior notice.

13. Force Majeure

13.1 The Company reserves the right to cancel, vary or suspend the operation of contracted sale if events occur
which are in the nature of force majeure including (without prejudice to the generality of the foregoing) fire, flood,
storm, plant breakdown, strikes, lockouts, riot, hostilities, non— availability of materials or supplier any other event
outside the control of the Company and the Company shall not be held liable for any breach of contract resulting from
such event.

14. Export Terms:

14.1 In these Conditions “Incoterms” means the international rules for the interpretation of trade terms of the
International Chamber of Commerce as in force at the date when the contract is made. Unless the context otherwise
requires, any term or expression which is defined in or given a particular meaning by the provisions of Incoterms and
these conditions, the latter shall prevail.

14.2 Where the Goods are supplied for export from the United Kingdom, the provisions of this Clause shall (subject to
any special terms agreed in writing between the Buyer and the Company) apply notwithstanding any other provision
of these conditions.

14.3 The Buyer shall be responsible for complying with any legislation or regulations governing the importation of the
Goods into the country of destination and for the payment of any duties thereon.

14.4 Unless otherwise agreed in writing between the Buyer and the Company, the Goods shall be collected (ex—
works) from the Company premises and the Company shall be under no obligation to give notice under Section 32(3)
of the Sale of Goods Act 1979.

15. General
15.1 These conditions of sale shall be construed in accordance with English Law.



15.2 The Company is a member of a group of Companies and accordingly the Company may perform any of its
obligations or exercise any of its rights hereunder by itself or through any other members of its group, provided that
any act or omission of any such other member shall be deemed to be the act or omission of the Company.

15.3 Any notice required or permitted to be given by either party to the other under these conditions shall be in writing
addressed to that other party at its registered office or principal place of business or such other address as may at the
relevant time have been notified pursuant to the provision to the party giving the notice.

15.4 No waiver by the Company of any breach of the contract by the Buyer shall be considered as a waiver of any
subsequent breach of the same or any other provisions.

15.5 If any provision of these conditions is held by any competent authority to be invalid or unenforceable in whole or
in part the validity of the other provisions of these conditions and the remainder of the provision in question shall not
be affected thereby.
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What is Digita Wordworth?

Ever since its launch in 1991, Wordworth® received world-wide acclaim. Today, with more than 250,000 users, it is
available in 13 languages.

Year after year, more people buy Wordworth® on recommendation than for any other reason. Best of all, it is now
available for Windows 95 users absolutely free.

Main Features

. Always WYSIWYG (what you see is what you get) display from screen to printed page.
Toolbar. Perform tasks by simply clicking an icon.
- Produce personalised standard letters and mail merge with Digita Organiser addresses.
- British English Collins spelling checker, with hyphenation, provided by Proximity Collins Linguibase-110,370
word dictionary and 26,000 Merriam-Websters legal medical supplement.
- Auto Librarian(TM) corrects errors as you type and lets you store text from documents and easily recall it at

any time.



What's New in This Version?

As this is the first version of Wordworth, there is nothing new. However, if you have any comments or suggestions
then please contact our Technical Support department so that they can feed them into the design process for the next
version.



Registering Wordworth

How to Register

1.

Print this topic and fill out
the details on the form
opposite.

Contact Digita, with the
information you have
entered on this form, to
receive your registration
number.

Choose Register
Wordworth (Help menu)
for you to type in the
registration number
supplied by Digita.

Marme:

Address;

Telephone:

M achine:

b emiony:

W ind o

Digita International Limited  Black Horse House Exmouth Devon EX8 1JL England
Telephone: (+44) 1 395 270 273  Facsimile: (+44) 1 395 268 893  Email: ww_sales@digita.demon.co.uk



Keyboard Shortcuts

Print this topic for an easy to use reference guide on keyboard shortcuts.

Menu Shortcuts
Key Action

Ctrl—N New
Ctrl—O Open

Ctrl—S Save

Ctrl—P Print

Ctrl—X Cut
Ctrl—C Copy
Ctrl—V Paste
Del Delete
Ctrl—A Select All

Ctrl—F Find

Ctrl—H Find and Replace
F3 Find Again

Ctrl—A Select All

Ctl—G Go To

Ctrl—D Duplicate
Alt—Enter Properties
F7 Spell Check

F1 Help

Shift Select Text

Formatting Shortcuts
Key Action

Ctrl Shift—F Font Format
Ctrl Shift—M Paragraph Format
Ctrl Shift—T Tabs Format

Ctrl Shift—3S Style Sheets Format

Ctrl—B Bold
Ctrl—1 Iltalic
Ctrl—U Underline
Ctrl—K Small Caps

Ctrl—L Align Left
Ctrl—R Align Right
Ctrl—E Align Centre
Ctrl—=J  Full Justify

Inserting Shortcuts
Key Action

Ctrl Shift—C Updating Time
Ctrl Shift—B Updating Date

Object Shortcuts
Key Action




Ctrl Shift—G Group
Ctrl Shift—U Ungroup

Navigation Shortcuts

Key Action

Cursor Left Move left one character
Cursor Right Move right one character
Cursor Up Move up one line

Cursor Down Move down one line
Home Beginning of line

End End of line

PageDown Previous page

PageUp Next page

Ctrl—Cursor Left Move left one word

Ctrl — Cursor Right Move right one word
Ctrl—Cursor Up Move up one paragraph
Ctrl—Cursor Down Move down one paragraph
Ctrl—Home Beginning of document
Ctrl—End End of document

Hold down the Shift key and apply the above navigation shortcuts to select text.



Dialog Controls

This topic will show you the

different controls used in Bepeat everny I1 _|: I
Wordworth dialogs.

Click a dialog control for

information on how to use it. I™ w/ide pags format I™ Separate list pages

Awailable Supplements: W R

ﬁ {* Fepeat ever

Luwards
' Computers
m-$24 Food and Drink
-] Health

Click the arrows on the right to adjust the value in the edit control.



Type your information in the box.



Click a box to select the option (you can select more than one in a group).



Click the arrows to move through the list, and then click your selection.
Click '+' to expand the topic and show more options.



Click the option you want (you can only select one).



Click the arrow to see a list of options and then click the option you want.



What You Can See
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This Help file uses the following typographic conventions.

Convention Use




Quotes Indicates words or characters you type. For example, "type My Birthday into the Title text
control". They are also used to indicate program, folder or disk names. For example,
"double-click the Wordworth.hlp file, which is in the Wordworth folder on your hard disk".

Bold Indicates a dialog, menu or menu command.
- Bulleted lists provide information.
b Arrowed lists show steps of a task.

Combination keysCtrl—P, for example, is a combination key press. This means hold down the Ctrl key and press the
P key. Then release both keys.

Insertion point (]) Blinking vertical bar which indicates the current editing position in a control or the page.

Mouse Pointer Commands

Point Position the pointer on an item.
Click Point to an item, and then quickly press and release the left mouse button.
Double-click Point to an item, and then quickly press and release the left mouse button twice.

Click here Al to change the double-click speed of your mouse from the Control Panel.
Drag Point to an item. Press and hold the left mouse button as you move the mouse to a new location. Then,
release the mouse button.

See also
Help on Dialogs

Help on Menus
Technical Support



Help on Menus

The menus list commands available to you. There are several types of menu, including drop-down menus, pop-up
menus and cascading menus.
Drop-down Menus

At the top of the main window there is a special area called the menu bar. This menu bar includes a set of entries
called menu titles. Each menu title provides access to a drop-down menu of commands.

When you choose a menu title with the left mouse button, a panel will appear with commands arranged in a column.
This panel is called a drop-down menu.

|X=N Edit “iew Fomat Tool: Window H
Hew. .. Ctrl+M

Open... Chrl+0

Cloze

Save Chril+5
Save bz

Frirt.... Chrl+F
Frint Presie
Fage Setup...

Send...

1 C:MProgram Filez\.. \Report wwd

E xit

Drop-down Menu
As the pointer moves over the list, the command beneath is highlighted. Clicking the left mouse button again will
perform the command highlighted.

Getting Help on Menus
k Position the pointer over the command to display basic help in the Status Bar.

See also
Help Overview

Help on Dialogs
Technical Support



Help on Dialogs

Dialogs obtain or display supplemental information necessary for the operation of the application. Dialogs usually
contain a selection of controls to display or obtain information.

Navigating a Dialog
You can navigate through the controls on a dialog by pressing Tab or Shift — Tab. Alternatively, hold down the Alt key
and press the underlined letter in the label of the control.

Getting Help on Dialogs
You can get help on a dialog by following these steps:
b Click the Help button.

If there is no Help button, the dialog may be a system dialog and therefore contains Help on each control:

b Click the What's This icon in the top right corner of the dialog and then click the control or label.
Alternatively, position the pointer over the object, click the right mouse button and choose What's This from

the pop-up menu.
By following these steps you will get a small help window containing an explanation of the control.

Find

| hﬂl
T

Find what; T
I Searches for the nest instance of the text vou zpecified in the

[~ Match whole word] — Find 'what box.

[T Match case

See also

Help Overview
Help on Menus
Technical Support



Contacting Digita

Electronically
URL  http://www.digita.com

Email: ww_supp@digita.demon.co.uk or ww_sales@digita.demon.co.uk
Compuserve:  100031,3032 (with "Wordworth Free" in the Subject line)

Other Means
Phone: 0891 616 944 (UK users only)

This support line is available to registered Wordworth users from 11am until 5pm. Calls are charged
at 36p per minute cheap rate and 48p per minute at all other times. Be sure to ask permission of the
telephone owner before calling.

Facsimile: 01 395 268 893

Post:  Wordworth Division
Digita International Limited
Black Horse House
Exmouth
Devon EX8 1JL



Technical Support

If you experience any problems with Digita Wordworth, please see if the problem is already shown in the
Troubleshooting sections:

General trouble with Wordworth
Trouble with files
Trouble with printing
If you cannot find your problem in any of the above topics contact Digita.



General trouble with Wordworth

Q

A

When | mail merge one of the label templates with a large number of clients, there is a very long pause
before the print dialog appears.

This is normal as Wordworth has to open each client individually and retrieve the details. If a lot of clients are
chosen for mail merging, this can take some time.

When | move my insertion point to the middle of a word, the letters in front of the insertion point
disappear as | type.

You seem to be in 'Overtype' mode. Press the Insert key on your keyboard.

When | move my cursor to the header or footer and type some letters, the screen flashes and nothing
appears.

There is not enough room in the header of footer for any characters.

Ensure that the Header and Footer Margins (Page Setup Options dialog, File menu) plus the height of your
characters, is less than the Top or Bottom Margin (Page Setup command, File menu).

For example:

If you are using 14pt text (0.2 inches in height) and your Header margin is 0.2 inches. Your Top margin should be
at least 0.5 inches.



Trouble with files

Q
A

N = > 0

w

| cannot save a Wordworth document.

You should check that the disk you are trying to save to is write-enabled and that you have sufficient free space to
save the file. If the problem persists, try saving to a different disk or drive.

How do | change the mail merge documents/templates that come with Wordworth, or create new ones?
To change a mail merge documents or template, follow these steps:
Choose Open (File menu)

Double-click the Mail Merge Documents folder if you want to change one of the mail merge documents, or the
Templates folder if you want to change one of the templates

Select the document you want to change and click the Open button.

4. Once you have made the changes you want to make, choose Save (File menu).

1
2.

1.
2.

To create a new mail merge documents or template, follow these steps:

. Create the document as normal

Save it into the appropriate directory.
You can insert the available mail merge fields by:
Choose Insert (Edit menu)
Select either Taxability Pro Merge Fields or Company Controller Merge Fields and click Insert. This will

display a list of the available mail merge fields which you can insert into your document.

Q
A

Can | change the label templates or create new ones?

No. If you have any problems using the existing label templates then contact Digita Technical Support, if you
would like a new label template added then send the sheet of labels to Digita Technical Support who may be able
to create the template for you.



Trouble with printing

Q | cannot print from Wordworth.

A You need to ensure that you either have a printer installed or that it is set up correctly.
From your Windows Start menu, choose Settings F Printers. If there are no printers in the folder, double-click Add
Printer and follow the on-screen instructions.

If a printer is already installed, select it and choose Properties (File menu). Click the Details tab and check
that you are using the correct Printer Driver.
Follow the Windows help file if you are still having problems.



Help Tour
To get a quick overview of how to use Wordworth, click each step in turn.

1 Creating a new Wordworth document
2 Finding your way around Wordworth

3 Using dialogs and their controls

4 Selecting text

5 Formating text characters

6 Changing the viewable document area
7 Saving your work

8 Printing your document

9 Opening previously saved documents



Create a new Wordworth document
1 Choose New (File menu) to open a new document window with a blank page.

If the Normal template was selected from the New dialog, the new document will use the default document
settings (page size, fonts and so on).

2 Instead of creating a new 'normal' document, a different document template can be used (facsimile, memo, letter
and so on).

See also
Create templates



Create templates

Once a document has been designed and created, you can save it so that it can be used again and again by saving it
as a template.

1 Choose Save As (File menu), and find the Templates folder (which should be in the Wordworth folder on your
hard disk).

2 Type the name of the template into the File Name edit control and click Save.

- When you create a new document (New command, File menu), you will be able to see the template name
that you have just saved.

- A template is always opened into an 'untitled' window so that it can be saved to a different location under a
different name.



Save your work

You should save your work at regular intervals so that you are less likely to lose work if there are problems with your
machine.

1 Choose Save (File menu) will save the current document to disk, in the normal "Wordworth Document" format,
using the current document name and path.

If the document is 'untitled’, you will be prompted for the name and destination of the file.

If you wish to save the document using either a different name, path or file format, choose Save As (File menu).

The Save As dialog will allow you to specify:
- The name
- The path (drive and directory) to store the document
- The file format (that is, a different format to the normal "Wordworth Document” style).



Path
The path is the physical location of a specific place on a specific disk drive.

For example, "C:\Program Files\Wordworth Letter Writer\Documents" is a path to the folder called Documents on your
computer.



Open a previously saved document
1 Choose Open (File menu) to open a file previously saved.

2 From the Open dialog you can select the document you want to open.

- If you wish to open a file that is not a Wordworth document (a Rich Text Format or plain ASCII file, for
example) select the file type from the Files of Type pop-down list. When opening Wordworth will detect the format
and open the file automatically.



Close your document
To close a document, either:

1 Choose Close (File menu).
2 Click the window close button (the crossed box within the top right corner of the Wordworth application screen).

Close Buttons
- If you close a new or modified document, Wordworth will ask if you wish to save the changes.



Print your document

1 Choose Print (File menu) to print the current document.

- If you have not already setup your printer, you must do so first.

2 From the Print dialog you can specify:

- The range of pages.

- The number of copies of each page.

- The arrangement of the pages.

To print a single page:

- Select the Pages radio button and type the page that you wish to print into both of the adjacent edit controls.
To print a range of pages:

- Select the Pages radio button and type the page range in the adjacent edit controls (for example, type '2'
and '5' if you wish to print pages 2 to 5 of your document).



Align and justify text

Wordworth aligns text relative to the left and right indents set for the paragraph.
1 Choose Paragraph command (Format menu) to display the Paragraph dialog.

2 Select the alignment method from the Justification pop-down list. You can align text left, right, centred, or fully
justified.
Alignment is applied to the current paragraph or selected paragraphs.
3 You can also align text using the icons on the Ruler:

Left, Right, Centred, Justified



Indents

Indents, shown on the ruler, are the left and right boundaries of your page.
— First line indent
1 z a

o= 4 4 4 4
tLrl!l't indent Right inrllrl!nl:j

These can be dragged on screen or set for each paragraph from the dialog.




Indent lines and paragraphs

Indenting changes the width and horizontal position of a paragraph relative to the left and right page margins. For
example, you can indent the first line, relative to the subsequent lines of the paragraph.

When you indent paragraphs using the ruler, Wordworth automatically updates indent settings in the Paragraph
dialog (Paragraph command, Format menu).

The ruler indent markers are the two triangles on the ruler (Left and First Line Indents) and the one triangle on the
right (Right Indent).

— First line indent

1 z a

1 T S S Y T A Y T o Y
= * * * *
tLrl!l't indent Right inrllrl!nl:j

This is a hanging indent, see how the frst line is
set further left than the rest of the
paragraph,

The settings bo achiewve this were:
Left: 0,E5in
Right 0.00in

First lime: -0.65in Hanging Indent

1 Drag the lower left triangle to indent the left of the paragraph, and to move just the first line of the paragraph, drag
the upper left triangle.

2 Drag the right hand triangle to indent the right of the paragraph.



Change line spacing

1 Choose Paragraph (Format menu) to set the line spacing from the Paragraph dialog, which is measured in
points.

2 Select an option from the Line Height pop-down list or type a specific value.

Auto, the recommended option, sets the line spacing appropriate to the font size. Loose allows extra space for
accents on foreign characters.

3 The Line Spacing pop-down list lets you select whether you wish the lines in the paragraph to be Single, Double
or 1% spaced (the gap between each line). This option is commonly used for educational or legal documents.

-
| '35

The line spacing can also be set using the ruler buttons:



Change spaces between paragraphs
The space between paragraphs can be specified to make documents clearer. For example:

Traditional Paragraph 5Spacing Preferred Paragraph Spacing
Documents that separate the paragraphs Documents that separate the paragraphs using
with a blank line look too spacey. the Paragraph Space Before and Space After

controls look better,

I:kaec:;hfj:ﬁrgﬂfaimi paragraphs Like thiz example. Trp it pour self and see. Select
R ) all the paragraphs and zet the Paragraph Space
After to "Bpt",

- Type a value into either the Before or After controls on the Paragraph dialog (Paragraph command,
Format menu).

Tip

- The value is measured in points and a number about half the height of the font size is usually the best.



Keep lines together over pages

You can stop a paragraph being split over a page break.
1 Choose Paragraph command (Format menu).

2 Select the Keep Lines Together option.



Set tabs

There are four tab styles in Wordworth:
it
4
o'y
W Left, Right, Centre, Decimal.
The current tab style is selected on the Ruler. To change the style click the appropriate tab icon.

Default tab stops are set on the ruler at regular intervals for all paragraphs in a document. When you set a tab,
Wordworth removes all default tab stops to the left of the new tab.

Setting tab stops using the ruler:
Select the paragraph(s) that you wish to contain the tabs.

Click a tab icon to select the tab style.
Click on the ruler where you want to set the tab.
To move a tab position, drag the tab across the ruler.

a Hh ON =

To remove a tab, drag the tab off from the ruler.

Tip
- You can also set or delete individual tabs, as well as specify the default tab stops, from the Tabs dialog
(Tabs command, Format menu).



Insert a header or footer

1

4

Ensure your document has headers and footers by selecting the Use Headers and Footers and Show on First
Page checkboxes(Page Setup Options dialog, File menu).

To insert a header or footer on all pages click the text frame at the top or bottom of the page.

The header or footer frame will then become active and a flashing cursor will appear ready for you to type your
text.

To return editing to the main document, just click the main document page.

Important
You must have enough room in your header or footer to contain the height of text you wish to insert.

Ensure the Top Margin (Page Setup dialog) plus the height of the characters is greater than the Header

Margin (Page Setup Options dialog).



Insert a page break

Wordworth automatically paginates your document as you type past the end of a page. However, you can manually
paginate your document before you get to the bottom of the page.

1 Choose Insert command (Edit menu).
2 Select Page Break from the list and click Insert.



Insert page numbers

Page numbers and page counts can only be inserted into a header or footer frame.

1 Click in the header or footer area to edit it.

2 Choose Insert (Edit menu).

3 Select Page Number from the list and click Insert. This will place the current page number at the insertion point.

4 Select Page Count from the list and click Insert. This will place the total number of pages at the insertion point.
This is useful for numbers such as "Page 1 of 15".

Tip

- The style used for the page numbers can be set to roman numerals or letters, for example. Set the style

from the Page Setup Options dialog (Page Setup command, File menu).



Insert the date and time

- Choose Insert (Edit menu) and select one of the date or time options:

- Current Date

Inserts the current date at the insertion point.

- Updating Date

— Inserts a date command, "{-DATE-}", at the insertion point, which is replaced by the current date at the time of
printing.

- Current Time

— Inserts the current time at the insertion point.

- Updating Time

— Inserts a time command, "{-TIME-}", at the insertion point, which is replaced by the current time at the time of
printing.

Tip
- The date and time format can be set from the Page Setup Options dialog (Page Setup command, File
menu).



Select text

Selecting a part of text

1 Hold down the shift key and move the insertion point with the cursor keys or mouse, or
2 Drag the cursor over any text with the mouse to select it, or

3 Hold down the Shift key and click with the mouse anywhere in the document.

Selecting all document text
- If you are editing text in your main document area (the insertion point is on the page), choose Select All
(Edit menu).
Note: When editing a Text Frame, Select All will just select the text in the frame.
Tip
- Double-click the mouse to select a word.

See also
Cancel a selection



Select objects

Selecting an object
1 Click the object with the mouse, or

2 Click the Selection Pointer tool [:3 .

Selecting all document objects
- Select one object and choose Select All (Edit menu).

See also
Cancel a selection



Cancel a selection
- To cancel the selection of text or objects, click away from the selection anywhere on the page.



Change the viewable document area

You can easily change how much of the document page you can see on screen.
- Choose one of the commands from the Zoom sub-menu (View menu):

Command Result

100% Normal Shows the page at 100% zoom

Fit Page Width Selects a zoom percentage that ensures that the width of the page is viewable
Fit Whole Page Selects a zoom percentage that ensures that the whole page is viewable

Custom Displays the Custom Zoom dialog from which you can specify a zoom percentage



Display header, footer and document margins
- The margin guides can be hidden or displayed using the Show Guides command (View menu).



Display special codes
- Choose Show Codes (View menu) to show or hide the display of special symbols which represent:
Symbol Description

Grey End of paragraph
Grey dot Space
Grey arrow Tab



Use the ruler

There are two rulers attached to a Wordworth window, one vertical and one horizontal.

- Show or hide the rulers using the Rulers command (View menu).

- The horizontal ruler displays the indent and tab settings for the current paragraph (the current paragraph is
identified by the position of the insertion point).

- The vertical ruler shows the position of the current paragraph on the page.



Format text characters
1 Select the text you wish to change.

2 Choose Font (Format menu) to display the Font dialog. This dialog is used to change the appearance of the
selected text.

- From the Font dialog, you can change the appearance of your text by:

- Using a different font

- Using a different size

- Applying a text style to the character (italic, bold etc.)

- The ribbon bar and the menus can both be used to change the font type, style and size.

See also

Change text styles



Change text styles

You can apply different text styles to selected (highlighted) text by:

1 Select the text you wish to change.

2 Choose one of the style commands from the Format menu or click one of the style icons on the ribbon bar:

Icon Style Description
Plain Text Turns off all styles, returns text to plain style
B Bold Text Embolden text to make it appear thicker (good for headings)
4 Italic Text Italicise text so that it slants to the right
4]

Underlined Text Underline text. Use the Underlining pop-up to select single or double underlining.
Superscript Text Place text above baseline of text.

Subscript Text  Place text below baseline of text.

- You can specify the size of super or subscript characters (as a percentage in relation to the current font size)
from the Page Setup Options dialog (File menu).

See also
Format text characters



Adjust margins
You can set both document page margins or margins within an individual text frame.

To change the page margins:
- Choose Page Setup (File menu) and type your margins into the appropriate edit controls.

To change margins within a text frame:

- Select the text frame, then choose Properties (Object menu) and type your margins into the appropriate
edit controls.



Insert special fields

You can insert page breaks and special fields into the current document.

- Choose Insert command (Edit menu)

- Double-click an entry in the list to insert it at the position of the insertion point and leave the dialog open.
Alternatively, select an item in the list and click Insert to insert it at the position of the insertion point and close the
dialo

- ° The items that can be inserted as follows:

Type Action

Page Break Wordworth automatically paginates your document as you type past the end of a page and on
to the next page.

You can manually paginate before you get to the bottom of the page by selecting this option.

Page Number Inserts the page number field at the insertion point. This field is updated on each page to show
the current page.

You can only insert Page Numbers into a header or footer.

The Numbering Style can be specified from Page Setup Options to display the page number
as a roman numeral, a letter or a number.

Page Count Inserts the total page count field at the insertion point. This field is updated whenever a page
is added or removed and is useful for creating numbers such as "Page 1 of 15".

You can only insert Page Numbers into a header or footer.

The Numbering Style can be specified from Page Setup Options to display the page number
as a roman numeral, a letter or a number.

Current Date Inserts the current date at the insertion point.

The Date Format can be specified from Page Setup Options to display the date in a different
style.

Updating Date Inserts a date field which is replaced by the current date when printing.

The Date Format can be specified from Page Setup Options to display the date in a different
style.

Current Time Inserts the current time at the insertion point.

The Time Format can be specified from Page Setup Options to display the time in a different
style.

Updating Time Inserts a time field which is replaced by the current time when printing.

The Time Format can be specified from Page Setup Options to display the time in a different
style.

Merge Fields Displays the Insert Merge Field dialog which allows you to add special mail merge fields for
conditional mail merging.

Organiser Merge Fields  Displays the Insert Organiser Merge Field dialog which allows you to add special mail
merge fields for merging with addresses from a Digita Organiser file.

Organiser Address Displays the Organiser Address dialog which allows you to select addresses from a Digita
Organiser file (selected in the File tab of the Options dialog) for inserting into the document.



Inserting mail merge fields

You can insert mail merge fields into the current document.

- Choose Insert command (Edit menu)

- Select the Merge Fields option and click Insert.

- Double-click an entry in the list to insert it at the position of the insertion point and leave the dialog open.
Select an item in the list and click Insert to insert it at the position of the insertion point and close the dialog.

- There are several selective commands which you can use while mail merging (they are enclosed in
chevrons (« or ») and preceded by a colon (:) to distinguish them from normal fields). These commands allow you to
skip certain fields or records, and even perform condition testing for querying the data.

Command Use
«FIELDO» ... «<FIELDn» Insert the n field from the database file. Starting at 0.
«NEXT» Skips to the next record in the database. It is useful when printing more than one

record on a page (like printing a sheet of address labels).

«:SKIP», «:ENDSKIP» These two command precede and follow a group of field names where you want the
empty fields to be filled with the contents from the following field. This is useful for
addresses where some fields in the address could be empty and you do not want gaps
in the middle of the address.

«:STOP» Stops the printing of the document.

«:IF "field" = "value"» Only proceeds if the "field" matches the "value".

«IF "field" = "value" NEXT» Will skip to the next record if the "field" contents match the "value".

«:IF "field" = "value" STOP» Will stop the printing of the document if the "field" matches the "value".
Other operators that can be used in place of the equals:

Operator Means

<= (or =<) Less than or equal to
>= (or =>) Greater than or equal to
<> Does not equal

< Less than

> Greater than

Note: All comparisons are case insensitive.

See also
Create personalised letters or labels



Create personalised letters or labels

Personalising letters or labels involves two steps. 1) Creating or finding the database file that contains the addresses,
2) Creating the document that will be merged with the database (the form letter).

Step One — Creating the database of names

- Choose New (File menu) and select Normal to create a new blank document

- Type each field of information (part of the address) separated by a Tab character

- Press Enter at the end of the record (address) and repeat the previous step and this step until all the
addresses have been created

For example ( is a tab character and { is a paragraph mark):
Jones Black Horse House Albion St Exmouthq

Smith 10 The Mews Exeterq

- When finished, choose Save As (File menu) and select Text Document from the Save As Type pop-down
list
Step Two — Creating the form letter
- Choose New (File menu) and select Normal to create a new blank document
— Create the document as you would like it to appear on all letters

Insert into the main document, special instructions called merge fields that tell Wordworth where to print
information from the database. When you Mail Merge the document, these merge fields will be replaced by
information from the database.
- Choose Insert (Edit menu), select Merge Fields and click Insert
- Select the appropriate fields («FIELD#») into the document as necessary

The fields that need inserting are the fields in the database. If for example, the database contains the
following data:

Jones Black Horse House Albion St Exmouthq
Smith 10 The Mews Exeterq

The fields you would need to insert into the document are:
«FIELDO» Which would be replaced with Jones, then Smith
«FIELD1» Which would be replaced with Black Horse House, then 10 The Mews
«FIELD2» Which would be replaced with Albion St, ...
«FIELD3» Which would be replaced with Exmouth, ...

Step Three — Producing the personalised letters

Once the database and form letter have been created the letters can be printed:

- Open the form letter and choose Mail Merge (Tools menu)

- Click Browse and select the database saved in step one

- Deselect the File Includes Header Record checkbox

- Type "Tab" in the ASCII Field Separator and type "Return” in the ASCIl Record Separator controls
- Click Print to print letters for all the addresses in the database

See also

Inserting mail merge fields



Clean up the screen

You can clear up the screen and hide all rulers, toolbars and close all currently open dialogs.
- Choose Clean Screen (View menu)



Display the drawing tools

- You can display a separate 'floating' drawing tools palette by choosing Drawing Tools (View menu)

- Select the appropriate icon from the palette then click and drag the mouse over the document page to create
the object

See also
Creating objects



Copy or move text and objects

You can copy and move text or objects using the clipboard. The following commands from the Edit menu manipulate
the clipboard and its contents:

Command Description

Cut Remove selected text or object and store it on the clipboard
Copy Copy selected text or object to the clipboard

Paste Insert contents of the clipboard at the insertion point

Erase Remove selected text or object

Once text or objects have been placed on the clipboard, you can repeatedly paste the contents into the same (or
another) Wordworth document.

- Using the keyboard

Keys Command

Ctrl — X Remove selected text or object and store it on the clipboard
Ctrl — C Copy selected text or object to the clipboard

Ctrl — V Insert contents of the clipboard at the insertion point

Delete Remove selected text or object

Backspace Remove selected text or object

- Using the toolbar

Cut, Copy and Paste can also be selected from the toolbar by clicking on the appropriate icon.

Icon Command
.?'o Cut
Copy
Paste
See also

Erase text and objects



Erase text and objects

- You can erase any selected text or object by pressing either the Backspace or Delete keys, or choosing
Clear (Edit menu).

- To erase text, press the Delete key to remove the character to the right of the insertion point, and the
Backspace key ('<-') to remove the character to the left.

- If you wish to remove portions of text, select it using the mouse or keyboard and either press the Delete or
Backspace keys, or choose Clear (Edit menu).

- If you wish to remove any object, select it using the mouse and either press the Delete or Backspace keys,
or choose Clear (Edit menu).

- To remove more than one object, select each in turn with the Shift key held down and then press the Delete
key.




Resize objects

1 When an object is selected, four small boxes appear around its perimeter. These small boxes, or handles, are
used to resize the object.

2 To resize an object, position the mouse pointer over one of the object handles, press the left mouse button and
drag the object outline to the new size.

To cancel the resizing, press the Escape key.



Move the insertion point

- The insertion point can be moved by using the cursor keys Up, Down, Left or Right.
- You can also use the mouse to position the insertion point directly at the position of the mouse pointer.



Find text
- Choose Find (Edit menu) to find a specific occurrence of a piece of text within the document.

- Choose Find Again (Edit menu) to repeat the last find command and search for the next occurrence of the
text you last specified.

Note: The Find and Find Again commands only operate within the current text frame.

Tip

The Find dialog may be left open whilst editing the document.

See also
Replace text



Replace text
- Choose Replace (Edit menu) to find a specific occurrence of a piece of text within the document and
replace it with another.

Note: The Replace command only operates within the current text frame.
Tip
The Replace dialog may be left open whilst editing the document.

See also
Find text



Repeat the last find command

- Choose Find Again (Edit menu) to repeat the last find command and search for the next occurrence of the
text you last specified.



Use the spell checker

- Choose Spell Check (Tools menu) to check the spelling of the entire document, from the position of the
insertion point, against the English Collins dictionary.

- To spell check a word, first select it and then choose Spell Check (Tools menu).

Note: The Spell Check only checks the words in the current text frame.

Tip
- You can add a word to the User Dictionary, which supplements the Collins Dictionary, by clicking Learn

from the Spell Check dialog.
- You can add, delete or edit words in your User Dictionary, by clicking the Spelling tab from Options (Tools

menu).



Draw shapes on the page

Wordworth can draw many different shapes on the page; lines, boxes, circles, ovals, polygons, arcs, frames and
more. To draw a shape:

1 Choose Drawing Tools (View menu) and click one of the drawing tool icons.
2 Drag an outline of the shape on the page, when the mouse button is released, the shape is created.
- The Polygon and Freehand shapes are the only exceptions to this rule:

The Freehand shape is drawn as one continuous object whilst the mouse button is held down; the Polygon tool
creates a point each time the Ctrl key is pressed and when the mouse button is released, the last point is joined to
the first.

- The Ctrl key, when creating a line, box or oval shape, will constrain the size as follows:
Object Constraint

Line Constrains line to 90°
Box Constrains box to a square
Oval Constrains oval to a circle

3 Choose Properties (Object menu) to display information about the frame and how it looks.

See also

Add objects to all pages
Arrange the layering of objects
Duplicate objects

Group and ungroup objects
Lock and unlock objects
Resize objects

Move an object

Information about objects



Create a text frame

A text frame is a small independent 'floating page' that contains text, which can be sized, altered and moved like any
other object.

1 Choose Drawing Tools (View menu) and click .

2 Drag an outline of the text frame on the page, when the mouse button is released, the text frame is created.
- The Ctrl key, when creating a Text Frame, will constrain the frame to a square.

3 Choose Properties (Object menu) to display information about the frame and how it looks.

See also

Add objects to all pages
Arrange the layering of objects
Duplicate objects

Group and ungroup objects
Lock and unlock objects
Resize objects

Move an object

Information about objects



Place a picture

Wordworth can import many different types of graphic file in any resolution or size, from 2 to 256 colours. These
include Windows Bitmap Files (BMP and DIB), PC Paintbrush (PCX), Tagged Image File Format (TIFF), Targa (TGA),
and JPEG (JPG).

- Choose Place Picture (Object menu) to place a picture into your document.

Alternatively:

1 Click from the Drawing Tools (View menu) and drag a picture frame onto the page.

2 With the frame selected, choose Place Picture (Object menu) to import the graphic into the frame.
This is useful if you wish to place a picture that is very large on the page at a specific point or size. You

dictate the size of the picture by creating the frame to the size you wish the picture to be.

- Information on pictures can be obtained to enable you to specify if the picture is "Hot Linked" or "Cool

Linked", the dimensions and position of it and whether you wish to have "Text Flow" around the picture.



Add objects to all pages
- Choose Add To All Pages (Object menu) to add any selected objects to all the pages in your document.
Any new pages that are created will have these objects automatically placed on them.

- To delete an individual object from just one page, select it and press the Delete key (or choose Clear, Edit
menu).

Note: Grouped objects cannot be added to all pages.



Arrange the layering of objects

You can specify the depth of an object in relation to the other objects on the page.

- To move an object in front of another, select it and choose Move Forward (Object menu), Move Backward
will move the object behind another.

- You can move an object right to the back of all other objects by choosing Send to Back (Object menu).
Alternatively, Bring to Front (Object menu) will bring the object to the front.

Icon Command

Move object in front of another

Move object to the front of all others

&
@ Move object behind another
Gy
Ch

Move object to the back of all others



Duplicate objects
- Choose Duplicate (Object menu) to quickly clone any selected objects.



Group and ungroup objects

Objects can be grouped together so that they act as one object, (for example, a group of objects all move together
and are sized together)

1 Select the objects you wish to group
2 Choose Group (Object menu)
- Choose Ungroup (Object menu) to split the group into its original separate objects



Lock and unlock objects

An object can be locked onto the page so that it cannot be removed, moved or changed.
1 Select the object or objects you wish to lock to the page

2 Choose Lock (Object menu) to lock the selected objects to the page

When the mouse pointer moves over a locked object, it changes into a padlock. A locked object also has hollow
handles when selected.

- Choose Unlock (Object menu) to unlock the objects so that they can be modified again



Move an object

- Move an object by selecting it and while holding down the mouse button, move the outline of the object to its
new position and then release the mouse button.

- The Ctrl key, when moving an object, will keep the object along the same horizontal or vertical axis.

- To cancel the moving of an object, press the Escape key whilst holding down the mouse button.

Note: While text flow is switched on for an object, it cannot be moved between pages. This also applies to objects
that have been 'Added to all pages'.

Tip
- Precise positioning can be obtained by selecting the object, and choosing Properties (Object menu).



Information about objects

When an object is selected, you can inspect its attributes by either double-clicking it, or choosing the Properties
command (Object menu).

Information about an object may consist of its position on the page, dimensions, colour, border style and colour, if it
repels text and so on.



Click to close the dialog, saving any changes



Click to close the dialog, without saving any changes



Click to apply changes without closing the dialog



Click to close the dialog



Allows you to select a template to use for a new document. Select Normal for a default blank document



Select a paper size from the pop-down list for the current document



Specify a custom amount for the width of the document



Specify a custom amount for the height of the document



Click to rotate the document so that it can be printed on it's side



Click to change the current document so that it has different margins, headers and footers for each odd and even
page



Click to allow objects to be created across an odd and even page. This is useful for banners, for example



Specify the left margin for the document. This is the distance between the left edge of the page and the left end of
each line with no left indent



Specify the top margin for the document. This is the distance between the top of the page and the top of the first line
on the main page (not including the header).



Specify the right margin for the document. This is the distance between the right edge of the page and the right end
of each line with no right indent.



Specify the bottom margin for the document. This is the distance between the bottom of the page and the bottom of
the last line on the main page (not including the footer).



Click to mirror the left and right margins on odd and even Facing Pages



Specify the number of columns for the document



Specify the gap between each column



Click to change more settings for the current document



Click to enable headers and footers on each page of the current document



Click to enable headers and footers on the first page. Useful for document title pages where it would be unticked



Specify the distance from the top of the page to the top of the first line of the header.

Header Margin Top Margin

Header

Drocument

The height of the Header is therefore: "Top Margin (minus) Header Margin'



Sets the distance from the bottom of the page to the bottom of the last line of the footer.

Document

Footer

Footer Margin Bottom Margin

The height of the Footer is therefore: 'Bottom Margin (minus) Footer Margin'



Specify the number from which page numbering starts.
You can insert a page number field using the Insert command (Edit menu)



Select the style used for page numbers. Choose from either standard decimal, roman numeral or other formats from
this pop-down list



Select the format of date fields used in the document.

You can insert a date field using the Insert command (Edit menu)



Select the format of time fields used in the document.

You can insert a time field using the Insert command (Edit menu)



Specify the height of superscript of subscript characters in relation to the current font



Specify the height of small caps characters in relation to the current font



Specify the page number that you wish to jump to



Select an item in the list and click Insert to insert it at the position of the insertion point and close the dialog.
Double-click an entry in the list to insert it and leave the dialog open



Select the colour name that you wish to modify



Specify the new name of the colour selected in the list



Shows the actual colour of the colour name selected in the list



Move the slider to adjust the red properties of the colour



Move the slider to adjust the green properties of the colour



Move the slider to adjust the blue properties of the colour



Select a zoom level from the pop-down list of type a custom value into the edit control.
- Select 100% (Normal) from the pop-down list to choose normal magnification
Select Fit Whole Page to automatically choose a percentage that will fit the whole page on the screen
Select Fit Page Width to automatically choose a percentage that will fit the whole width of the page on the
screen



Selects how many pages are viewed across the screen at the same time. This is useful for viewing facing pages side
by side.

Because the first page is always a right hand page, you will notice that the first left hand page area is black when the
zoom level is low



FONT STUFF

Colour

Specifies the colour of selected text or numbers. Unless you've changed the text colour in the Windows Control
Panel, clicking Auto sets the text colour to black.

Strikethrough
Draws a line through selected text - useful for marking revisions.

Small Caps

Formats selected text as small capitals. Uppercase letters appear as normal capitals, lowercase letters appear as
smaller capitals, the size of the lowercase capitals can be specified from the Page Setup Options dialog

Underline
Formats the selected text with an underline. Select the style of underline from the Underlining pop-down list

Underlining
Select the style of the underline if the Underline checkbox is ticked

Position

- Normal

—formats selected text or numbers as normal non-superscript/subscript.

- Superscript

—formats selected text or numbers as superscript, select the Superscript check box. The size and position of the
superscript text depend on the font and the percentage specified from the Page Setup Options dialog

- Subscript

—formats selected text or numbers as subscript, select the Subscript check box. The size and position of the
subscript text depend on the font and the percentage specified from the Page Setup Options dialog

Sample
Shows how your text will look with the options selected on this dialog



Specify the amount of space before the first line of each selected paragraph



Specify the amount of space following the last line of each selected paragraph



Specify the exact height of each line of the paragraph



Specify the amount of vertical space between lines of a paragraph



Specify the indentation of the paragraph from the left margin. If you want text to appear in the left margin, specify a
negative number



Specify the indentation of the paragraph from the right margin.. If you want text to appear in the right margin, specify
a negative number



Specify the amount of indentation for a first-line or hanging indent



Specify the position of selected paragraphs in relation to the paragraph indents. No justification will occur if the
paragraph contains any tab characters



Click to ensure that all lines of the paragraph are kept together over page breaks



Click to allow words in this paragraph to be hyphenated if necessary



TABS LIST
Shows the tabs currently set for the selected paragraphs.
Select a tab stop and change the settings in the New Tab group to change the selected tab stop



Click to create a new tab stop using the values specified in the New Tab group



Click to delete the tab stop selected in the Tabs Set list



Click to delete all the tab stops in the Tabs Set list



Specify the spacing between default tab stops



Click to change the tab selected in the Tabs Set to a left aligned tab stop



Click to change the tab selected in the Tabs Set to a right aligned tab stop



Click to change the tab selected in the Tabs Set to a centred tab stop



Click to change the tab selected in the Tabs Set to a decimal aligned tab stop



Specify the position of the tab stop on the ruler relative to the left edge of the page (and not the left paragraph indent)



Specify the character that is used to fill the empty space between the text and the left of the tab stop



Shows the styles currently available for the document



Click to create a new style



Click to copy the style selected in the list



Click to delete the style selected in the list



Specify the name of the style selected in the list



Select which attributes the style is to change



Click to choose the format which you wish to change for the style selected in the list



Select the style which the new style will be based on



Select the style for the following paragraph. Ideal for heading styles where the paragraph after will usually be Normal



Shows the attributes of the selected style



Click to import the styles from another Wordworth document



Shows the word in the document that is not in the dictionary



Shows the closest suggestion for the unknown or incorrectly spelt word.
The contents of this control replaces the unknown word when either Replace or Replace All are clicked



Shows the more common alternatives for the unknown or incorrectly spelt word if the Make Suggestions checkbox is
ticked



Click to show proposed alternatives for the unknown or incorrectly spelt word



Click to ignore the currently selected word and search for the next unknown or incorrectly spelt word



Click to ignore all occurrences of the unknown or incorrectly spelt word and continue checking



Click to replace the unknown or incorrectly spelt word with the contents of the Replace With control



Click to replace all occurrences of the unknown or incorrectly spelt word with the contents of the Replace With
control



Click to add the unknown or incorrectly spelt word to the User Dictionary so that it is not corrected again.
Click the Spelling tab (Options dialog, Tools menu) to view or edit the contents of the User Dictionary



Click to automatically capitalise occurrences of days and months as they are typed



Click to enable the automatic replacement of letters and words as they are typed



Specify the text of the entry you wish to replace



Specify the text that you wish to replace when the text specified in Replace is typed



Shows the entries available that will be replaced as you type



Click to add the text typed into the Replace and With controls as a new auto replacement entry



Click to delete the selected entry from the list



Click to insert the selected list entry, into the document at the insertion point



Shows the document name



Shows the folder where the document was saved



Shows the date the document was created



Specify a description for the document



Shows the time the current revision of the document has been edited



Shows the total time the document has been edited



Click to show statistics on all the text in the current document



Click to show statistics on just selected text in the current document



Shows the number of words for the option selected by the radio buttons



Shows the number of characters for the option selected by the radio buttons



Shows the number of lines for the option selected by the radio buttons



Shows the number of pages for the option selected by the radio buttons



Shows the number of paragraphs for the option selected by the radio buttons



Shows the number of pictures for the option selected by the radio buttons



Click to view more statistics on the current document



Shows the revision number of the document, or the number of times it has been opened



Shows the time the document was last printed



Shows when the document was last saved



Specify the person editing the document



Click to sort the selected paragraphs into ascending order



Click to sort the selected paragraphs into descending order



Specify the name of the source ASCII data file with which to merge the current document



Click to choose the source ASCII data file from an Explorer dialog



Specifies whether the first record in the data file shows the field names.

If ticked, the data in the first record is the field name that needs to be inserted into the document between the « »
characters. If not ticked, the field names inserted into the document must be «FIELDx» where x is the field number
starting at 0.



Select the format of the data file. The formats in the pop-down list specify different field and record separators



Specify the character that is used in the data file to separate each field. Alternatively, select one of the separator
types from the pop-down list



Specify the character that is used in the data file to separate each record. Alternatively, select one of the separator
types from the pop-down list



Click to show an outline of all text frames in the document. These frame outlines are not printed



Click to show margins (as dotted grey lines) of the document and all text frames. These margin guides are not printed



Select the number of 'handles' that objects will have when selected. Handles are small boxes that are used to resize
an object



Select the measurement unit that is used in the document for margins, object positioning, rulers and column gaps



Shows the words that have been added to the User Dictionary. These words are used as a supplement to the
supplied dictionary for use when spell checking



Specify a word that you wish to add to the User Dictionary



Click to add the word typed in the previous control to the User Dictionary



Click to delete the selected word from the User Dictionary



Click to enable hyphenation in the current document. Paragraphs that will be hyphenated will be those that have the
Allow Hyphenation checkbox selected from the Paragraph Format dialog



Click to check the spelling of words as you type. If the word is unknown the word will flash



Specify the default folder for opening and saving documents



Click to choose the default folder for opening and saving documents from a list



Specify the default folder for importing pictures



Click to choose the default folder for importing pictures from a list



Specify the location and name of the Digita Organiser file that you wish to use for the Insert Address facility



Click to choose the location and name of the Digita Organiser file that you wish to use for the Insert Address facility
from an Explorer dialog



Use this dialog to easily create new documents, open existing documents, or open documents which allow you to
mail merge.

This dialog will open every time Wordworth is started. You can display it at any other time by choosing EasyStart
(Help menu)



Use this dialog to easily create new documents, open existing documents, or open documents which allow you to
mail merge.

This dialog will open every time Wordworth is started. You can display it at any other time by choosing EasyStart
(Help menu)



Shows template documents that have been saved in the Templates folder on your computer.

A template document is used as a basis for creating new documents; it can have margins, objects, styles and so on
that will make it easier to create consistent documents.

Select a template that you wish to use and click Create



Shows documents in your default documents folder. Select a document and to open it, click Open



Shows documents in your Mail Merge Documents folder. Select a document and to open it, click Open



Click to show this dialog every time Wordworth is started



Register this preview version of Wordworth now to stop this dialog from appearing.
When registered you will also get advance notice of the special upgrade deal to the release version later this year



Follow the steps to register this copy of Wordworth



Follow the steps to register this copy of Wordworth



Specify the registration number given to you by Digita.
If the number is valid, the Register Now button becomes available



Click to register this copy of Wordworth.

Type a valid number into the edit control to enable this button, then click to accept the number and stop this dialog
from appearing



Click to close the dialog without registering at this time



Click to show a help topic giving instructions on how to register this copy of Wordworth



Digita's Stew Rabbit. Wherever you see Stew you will find information on registering your Digita product



Shows the product name and graphic



Shows the product name



Shows the product version and revision number



Shows information on the owners and date of copyright



Shows the address and contact details of Digita



Shows the people involved in producing this version of Wordworth



Shows the standard company disclaimer



Specify the position of the object from left edge of the page



Specify the position of the object from top edge of the page



Specify the diameter of the object



Specify the width of the object



Specify the height of the object



Select a type of line ending



Specify the internal fill colour of the object



Specify the border colour of the object if the Border Thickness is not 'None'



Specify the thickness of the edge of the object



Specify the style of the line



Specify the border type of the object



Select the flow of text around the object



Select the distance between the flow of text and the object



Shows the number of objects within the selected group



Specify the number of sides for the selected object



Specify the angle of rotation for the selected object



Specify the margin from the left edge of the selected text frame



Specify the margin from the right edge of the selected text frame



Specify the margin from the top edge of the selected text frame



Specify the margin from the bottom edge of the selected text frame



Specify the number of columns for the selected text frame



Specify the gap between the columns of the selected text frame



Click to ensure that the picture maintains its aspect ratio, or proportions, within the frame



Select how the picture is linked to the document.
- No Link

— picture is saved in the document. This means that the file size will be larger but the picture will never be lost.
- Cool Link

— a link to the picture is saved in the document. This means that the file size will be smaller but the picture will
always have to be in the same place or the link will be broken.



Shows the filename and location of the picture



Shows a description of the size, original size and format of the picture



New command (File menu)
Creates a new document based on a choice of templates.



O New button (Standard toolbar)
Creates a new, blank document based on the Normal template.



= Open command (File menu)
Opens a selected document.



Close command (File menu)
Closes the active document without quitting the application. To close all open documents choose Exit (File menu).



H Save command (File menu)
Saves the active document with its current filename, location, and file format.



Save As command (File menu)
Saves the active document with the filename, location, and file format you specify.



Print command (File menu)
Displays printing options and prints all or part of the document.



El Print Preview command (File menu)
Shows how a document will look when you print it. Use the Print Preview toolbar to make changes before you print.



% Print button (Standard Toolbar)
Prints one copy of the active document using the current print settings.



Page Setup command (File menu)
Changes margins, paper size, page orientation and other page options for the entire document.



Send command (File menu)
Sends a mail message with the active document as an attachment.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



File List command (File menu)
Opens the file. Click the number or name that corresponds to the file you want to open.



Exit command (File menu)
Exits the application.



¥? Undo command (Edit menu)
Reverses the last deletion of text.



— Cut command (Edit menu)
Removes the selection from the active document and places it on the Clipboard.



— Copy command (Edit menu)
Copies the selection from the active document and places it on the Clipboard.



— Paste command (Edit menu)
Inserts the contents of the Clipboard at the insertion point, replacing any selection.



Clear command (Edit menu)
Removes selected text or graphics.



4 Find command (Edit menu)
Searches for specified text in the active document.



Replace command (Edit menu)
Searches for and replaces specified text in the active document.



Find Again command (Edit menu)
Searches for text specified in the previous Find operation.



Ly Go To command (Edit menu)

Moves the insertion point to a specified page in the active document.



E Insert command (Edit menu)
Inserts various items such as Page Breaks, Page Numbers, Updating Date fields, in the active document at the

insertion point.



£ Insert Address button (Standard toolbar)
Inserts an address from your choice of Digita Organiser file, in the active document at the insertion point.



Colours command (Edit menu)
Edits the colour values of the named colours available for applying to text and drawing objects.



Select All command (Edit menu)

Selects all text in the active frame. If you are working with headers, footers or text frames, the Select All command
will only select the text in the frame which contains the insertion point.



Clean Screen command (View menu)
Removes all toolbars, rulers, status bar and property sheets so that the full screen area can be used.
To turn each element back on, choose the relevant command from the View menu.



100% (Normal) command (View menu)
Changes the magnification of the document to 100% which is the actual size that the document will be printed.



Fit Page Width command (View menu)
Changes the magnification of the document so that the width of the page fits within the Wordworth screen.



Fit Whole Page command (View menu)
Changes the magnification of the document so that the whole page fits within the Wordworth screen.



,O Zoom Custom command (View menu)
Changes the magnification of the document to a specific percentage.



Zoom In command (View menu)
Increases the magnification of the document by 10% so that the page and its contents appear bigger.



Zoom Out command (View menu)
Reduces the magnification of the document by 10% so that the page and its contents appear smaller.



Toolbar command (View menu)
Displays or hides the standard toolbar, which you can use to perform standard functions like Open and Save.



Formatting command (View menu)

Displays or hides the formatting toolbar, which you can use to perform text editing functions like changing the font, or
applying the Bold style.



@ Drawing Tools command (View menu)
Displays or hides the drawing tools toolbar, which you can use to select or create drawing objects.



Rulers command (View menu)

Displays or hides the horizontal and vertical rulers, which you can use to change paragraph indents, page margins,
and other spacing settings.



Status Bar command (View menu)

Displays or hides the status bar, which you can use to view the position of the insertion point or see help on menu
commands and buttons.



¥ show codes command (View menu)
Displays or hides non-printing characters such as tab characters and paragraph marks.



Show Guides command (View menu)
Displays or hides margins, headers and footers, and text frame guides.



%
Font command (Format menu)
Changes the font attributes and character spacing of the selected text.



[L_-. Paragraph command (Format menu)
Changes the appearance of the selected paragraphs (line spacing and justification, for example).



Style Sheets command (Format menu)
Defines or applies to the selection a combination of paragraph and font formats, called a style.



Tabs command (Format menu)
Controls the position and alignment of tab stops and determines the type of leader character.



Style Sheet (Formatting toolbar)

Marmal j

Changes the style of the selected paragraphs or text. Select a style sheet from the pop-down list or type a specific
style in the edit control.

A plus sign ‘+’ after the style name shows that the style has been modified after being applied to the paragraph or
text.




Font Name (Formatting toolbar)

[l =l
Changes the font of the selected text and numbers. Select a font name from the pop-down list or type a specific name
in the edit control.

There are two types of font shown in the pop-down list:
T Scalable TrueType fonts
Fonts available in your printer




Font Size (Formatting toolbar)

Changes the size of the selected text and numbers. Select a pre-defined size from the pop-down list or type a specific
value into the edit control. The sizes available in the list depend on the printer and the selected font.



KK Small Caps (Formatting toolbar)
Changes the format of the selected text to small capital letters.



Plain command (Format menu)
Removes any formatting applied to the selected text.



— Bold command (Format menu)
Formats the selected text and numbers as bold. If you click the button again, the formatting is removed.



— ltalic command (Format menu)
Formats the selected text and numbers as italic. If you click the button again, the formatting is removed.



— Underline command (Format menu)
Underlines the selected text and numbers. If you click the button again, the formatting is removed.



Superscript command (Format menu)
Changes the format of the selected text to superscript.



Subscript command (Format menu)
Changes the format of the selected text to subscript.



— Centre (Formatting toolbar)
To centre selected paragraphs, click the Centre button.



— Justify (Formatting toolbar)
Aligns or justifies paragraphs at the left and right paragraph indents.



— Align Left (Formatting toolbar)
To align selected paragraphs at the left indent, click the Align Left button. If you want to align a paragraph relative to
the left margin, make sure the paragraph is not indented.



— Align Right (Formatting toolbar)
To align selected paragraphs at the right indent, click the Align Right button. If you want to align a paragraph relative
to the right margin, make sure the paragraph is not indented.



— Single Space (Formatting toolbar)
Sets paragraph line spacing to single spacing.



— Double Space (Formatting toolbar)
Sets paragraph line spacing to double spacing.



— Left Tab (Formatting toolbar)
To align tabbed text to the left of a tab stop, click the Left Tab button and click on the horizontal ruler where you wish
the text to be aligned when the Tab key is pressed.



— Right Tab (Formatting toolbar)
To align tabbed text to the right of a tab stop, click the Right Tab button and click on the horizontal ruler where you
wish the text to be aligned when the Tab key is pressed.



— Centre Tab (Formatting toolbar)
To centre tabbed text under a tab stop, click the Centre Tab button and click on the horizontal ruler where you wish
the text to be centred when the Tab key is pressed.



— Decimal Tab (Formatting toolbar)
To align the decimal point of tabbed text under a tab stop, click the Decimal Tab button and click on the horizontal
ruler where you wish the text to be aligned when the Tab key is pressed.



Place Picture command (Object menu)
Inserts a graphic on the current page, or within the selected Picture Frame object.



— Move Forward command (Object menu)
Moves the selected drawing object in front of the immediate overlapping objects.



— Move Backward command (Object menu)
Moves the selected drawing object behind the immediate overlapping objects.



— Bring To Front command (Object menu)
Places the selected drawing object in front of other overlapping objects.



— Send To Back command (Object menu)
Places the selected drawing object behind other overlapping objects.



Group command (Object menu)
Assembles selected drawing objects into a single object so they can be moved or changed as a group.



Ungroup command (Object menu)
Disassembles a previously grouped object into individual objects so each can be moved or changed individually.



Lock command (Object menu)
Attaches the selected object to the page so that it cannot be moved or sized.



Unlock command (Object menu)
Detaches the selected object from the page so that it can be moved or sized.



Duplicate command (Object menu)
Makes a copy of the selected object and places it on the page, offset from the original.



Add To All Pages command (Object menu)
Adds the selected object to all current and new pages at the same position.



Properties command (Object menu)
Specifies the position, colours, styles and text flow of the selected drawing object.



— Selection Pointer button (Drawing Tools toolbar)
Changes the pointer to an arrow so you can select drawing objects. You can use the selection pointer to click objects
or to drag a selection rectangle around objects to select them.



|; Line button (Drawing Tools toolbar)
Lets you draw a line in your document. Click with the left mouse key and drag to create a line between the two points.

Hold down the Ctrl key to draw a straight line at 90°.
Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



= Rectangle button (Drawing Tools toolbar)

Lets you draw a rectangle in your document. Click with the left mouse key and drag to create a rectangle between the
two points. Hold down the Ctrl key to draw a square rectangle.

Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



. Rounded Rectangle button (Drawing Tools toolbar)
Lets you draw a rounded rectangle in your document. Click with the left mouse key and drag to create a rectangle

with rounded corners between the two points. Hold down the Ctrl key to draw a square rounded rectangle.
Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



O Circle button (Drawing Tools toolbar)

Lets you draw a circle in your document. Click with the left mouse key and drag to create a circle whose diameter is
between the two points.

Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



- Ellipse button (Drawing Tools toolbar)

Lets you draw an ellipse in your document. Click with the left mouse key and drag to create an ellipse between the
two points. Hold down the Ctrl key to draw a circle.

Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



{3" Polygon button (Drawing Tools toolbar)
Lets you draw a polygon in your document. Click with the left mouse key and drag to create each side of the polygon.

With the mouse key still pressed down, press the Ctrl key to create a new point and start a new side.
Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



{—\? Regular Polygon button (Drawing Tools toolbar)
Lets you draw a regular polygon in your document. Click with the left mouse key and drag to create a regular polygon

between the two points.
Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



- Curve button (Drawing Tools toolbar)
Lets you draw a curve in your document. Click with the left mouse key and drag to create a curve between the two

points.
Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



i Freehand button (Drawing Tools toolbar)
Lets you draw a freehand line in your document. Click and drag with the left mouse key create a line.
Select the object and choose Properties (Object menu) to specify the position, colours, styles and text flow.



— Text Frame button (Drawing Tools toolbar)
Lets you draw a text frame in your document. Click with the left mouse key and drag to create a frame between the

two points. Hold down the Ctrl key to draw a square frame.
Select the object and choose Properties (Object menu) to specify the position, colours, styles, margins, columns

and text flow.



— Picture Frame button (Drawing Tools toolbar)
Lets you draw a picture frame in your document. Click with the left mouse key and drag to create a frame between

the two points. Hold down the Ctrl key to draw a square frame.
Select the object and choose Place Picture (Object menu) to insert a picture into the frame.



RE
s/r“ Spell Check command (Tools menu)
Checks spelling in the current document, excluding the text in headers, footers and text frames.



REC
= Auto Librarian command (Tools menu)
Automatically corrects text as you type or allows you to store and insert text you frequently use.



Statistics command (Tools menu)

Displays information about the current document such as the number of words, how long it has been edited and when
it was last saved.



Sort command (Tools menu)
Sorts the selected paragraphs in alphabetical order.



Mail Merge command (Tools menu)
Merges the special merge fields in the current document with a database such as a mailing list.



Options command (Tools menu)
Modifies settings in Wordworth that control screen appearance, default folders and spell checking.



New Window command (Window menu)
Opens a new window with the same contents as the active window.



Cascade command (Window menu)
Displays all open documents in an overlapping fashion so that each can be seen.



Tile command (Window menu)
Displays all open documents side by side so that they do not overlap.



Arrange Icons command (Window menu)
Displays all minimised document icons in order so that they do not overlap or disappear.



Split command (Window menu)
Splits the active window into panes. Remove the split by dragging the split bar off the side of the active window.



1, 2, 3... command (Window menu)
Switches to the document and makes it active.



@ Help Topics (Help menu)
Displays the Help Topics dialog for navigating around the help guide.
Click to display the help topics dialog from which you can select help on an appropriate problem.



A? What's This? (Help menu)

Changes mouse pointer into Context Help mode (D\*.?). When in Context Help mode, you can choose menu
commands, click icons or areas of the display to show relevant help topics.

Press the Esc key to change out of Context Help mode.



EasyStart (Help menu)

Lets you create, open or mail merge documents quickly and easily using a simple dialog that appears each time
Wordworth starts.



Register Wordworth (Help menu)
Lets you register Wordworth so that the registration screen no longer appears.



About Wordworth command (Help Menu)
Displays the version number of this Digita application; copyright, legal, and licensing notices.



Wordworth Document

You can view, edit or print this document.



Caption Bar

To move a window or dialog box, drag its caption bar. To maximise a window or restore it to its previous size and
location, double-click the title bar.



Minimize command (Control menu)

To reduce an application or document window to an icon on the Task Bar, click =l inthe upper-right corner of the
window, or choose Minimize on the application or document Control menu. To restore the window to its previous
size and location, choose Restore.



Maximize command (Control menu)

To enlarge an application or document window to fill the screen, click El in the upper-right corner of the window, or
choose Maximize on the application or document Control menu. To restore the window to its previous size and
location, double-click the title bar.



Maximize command (Control menu)

To enlarge an application or document window to fill the screen, click El in the upper-right corner of the window, or
choose Maximize on the application or document Control menu. To restore the window to its previous size and
location, double-click the title bar.

Restore command (Control menu)

To restore a window to its previous size and location, click il in the upper-right corner of the window, or choose
Restore on the application or document Control menu.



Close command (Control menu)

To close the application, click El in the upper-right corner of the window, or choose Close on the application or
document Control menu.



Move command (Control menu)
To use the arrow keys on the keyboard to change the location of the application or document window, choose Move.



Restore command (Control menu)

To restore a window to its previous size and location, click il in the upper-right corner of the window, or choose
Restore on the application or document Control menu.



Size command (Control menu)
To use the arrow keys on the keyboard to change the size of the application or document window, choose Size.



Next Window command (Control menu)
To edit the next available window choose Next on the document Control menu.



Drawing Object
To change the style or position of this object, double-click it or choose Properties (Object menu).



Selected Text

To change the style of the selected text choose an appropriate text style from the Format menu, use the Formatting
Toolbar, or choose Font (Format menu) and change the options as appropriate.



Text Page

To change the style of text following the insertion point, choose an appropriate text style from the Format menu, use
the Formatting Toolbar, or choose Font (Format menu) and change the options as appropriate.

Change any options relating to the paragraph, such as line spacing or justification, by choosing Paragraph (Format
menu).



Drawing Tools
Contains buttons that give you quick access to drawing objects.

To see the name of a button, point to it with the mouse. To display or hide toolbars, use the View menu. To make an
anchored toolbar a floating toolbar, or vice versa, double-click a blank area on the toolbar.



Formatting Toolbar
Contains buttons that give you quick access to many text formatting commands and features.

To see the name of a button, point to it with the mouse. To display or hide toolbars, use the View menu. To make an
anchored toolbar a floating toolbar, or vice versa, double-click a blank area on the toolbar.



Rulers
To change the settings for indents, margins and tab stops, drag the markers on the horizontal ruler.

As you move the insertion point in the document, the markers on the ruler also move to reflect settings for the
paragraph that contains the insertion point.



Standard Toolbar
Contains buttons that give you quick access to many standard commands and features.

To see the name of a button, point to it with the mouse. To display or hide toolbars, use the View menu. To make an
anchored toolbar a floating toolbar, or vice versa, double-click a blank area on the toolbar.



Status Bar

The bar at the bottom of the document window that displays information about a command or toolbar button, an
operation in progress, or the location of the insertion point.

The right side of the status bar shows whether modes such as Caps Lock are turned on. To display or hide the status
bar, use the View menu.






